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1. INTRODUCTION  

 

Design is a multifaceted and complex phenomenon that has been studied over the years by 

researchers of various disciplines. This consequently lead to varying philosophies and methods 

to approach the subject. From only being studied as a phenomenon and as a science over the 

past several decades, researchers have recently started approaching this subject from a 

neuroscientific point of view. 

This thesis is an attempt to lay down the foundations of studying the design process from a 

neuroscientific perspective. The first step to achieve that goal was to carry out a review and 

establish a state of the art in existing design research that employed neuroscientific tools. A 

feasibility study was then carried out to evaluate the pros and cons of existing neuroscientific 

tools and their applicability to design research. In the end an experiment was designed and 

conducted, and the results were compiled to evaluate if such techniques are feasible in taking 

the first step towards developing a neuroscientific theory of the design process. 

Chapter 2 starts of by touching on the different definitions and fields of Design, Neuroscience, 

Creativity and Divergent thinking. The first part explains design science, the design process 

and outlines the several research methods that have been adopted in order to study the design 

process. The second part applies the same approach on creativity, divergent thinking and their 

possible connection to neuroscience. A state of the art in neuroscientific research in design is 

then established and comparison is provided among the results of the existing research and 

potential directions that can be adopted for future researcher. Finally, the choice of tool for 

the experiment is discussed and a research question is proposed. 

Chapter 3 explains the design of the experiment. It discussed the process of selecting 

participants, EEG apparatus, experiment procedures, the tasks and the raw data collected.  

The first part of Chapter 4 explains step by step the data preparation and cleaning process in 

the form of a guide that can be used for similar purposes in future researches. It concludes by 

explaining the algorithms that were used for carrying out the final analysis. 

Chapter 5 compares the findings of our analysis to look for patterns in EEG data and to check 

if our results are concurrent with existing research. We then conclude with what we learnt from 

our experiment and how future researches can be designed to obtain more accurate results. 
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2. NEUROSCIENCE AND DESIGN  

 

2.1 Design Science and the Design Process 

A generic definition of design is essential before moving towards a discussion of design 

science. As described by Professor John S Gero, design is the process by which man changes 

the physical and virtual world they inhabit (Gero, 2013). Herbert Simon, a pioneer in the 

existing understanding of design, also defines it as any purposeful activity that aims at 

changing existing situations into preferred ones (Simon H.A., 1969). Generic definitions like 

these are vital to encompass the many generic, yet essential, features of design. Essential to 

the act of designing is, as pointed out by Herbert’s definition, is the clear distinction between 

desirable and undesirable states. Design is used as both, a noun, as well as a verb. The act 

being implied by the verb ‘designing’ while the result implied by the noun ‘design’ (Gero, 

2013). 

Simon H.A touches on a much broader view of design in his book “The Sciences of the 

Artificial” (1969). He incorporates a very wide variety of artefacts that aren’t essentially related 

to technology as was the preceding view. To attract intellectuals towards the development of 

methods and tools for supporting design, he encouraged to study design from a scientific 

viewpoint. He stimulated the development of systematic and formalized techniques of 

research that could be applied across various design disciplines, the most obvious ones being 

architecture, engineering, computer science and management studies.  

Paul Johanesson, provides a comparison of design science to other similar discipline to fully 

understand its nature. Examples include Medicine and Economics as a science; they develop 

models to study the working of organisms and economy, respectively, and improve their 

health in the preferred direction. Though there are similarity among these different fields of 

science, design science is distinctive by being focused on the design phenomena 

(Johannesson, 2014:13). Johannesson elaborates further in his book “An introduction to Design 

Science” that design science also wants to change the world and improve it and not only 

describe, explain or predict it.  

A distinction must be made between the “science of design” which views design as a 

phenomenon to be studied and “design science” which aims to develop scientifically based 

methods and tools to improve design action with a normative approach (Cantamessa, 

2016:15). Nigel Cross, in his book “Designerly ways of Knowing” makes a further clarification 

as follows. 
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Figure 1 - The relationships between design and science (Cross, 2001) 

 

Both design and design science may seem similar by focusing on the development of artefacts 

and aiming at novelty. Their differences lie in their purpose with respect to their generalizability 

and contribution to knowledge. 

The design process is also described as tackling a problem by following a rigid series of pre-

defined steps. These steps mainly involve defining the problem, deducing the requirement 

specifications, selecting, prototyping and testing along with the development of the testing 

criteria. The focus of this thesis is on the cognitive process of design. Since a major part of 

design cognition is visual and not verbal; the cognitive process of designing can be quite 

complex. Even expert designer can find it challenging to explain the thought process behind 

their decisions (Suwa, Purcell, and Gero 1998). Professor John S. Gero proposed the Function 

Behavior Structure ontology of design object, which is often used to model the design process.  
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2.1.1 Function – Behavior – Structure (FBS) Ontology and the FBS Framework 

During the 60’s and 70’s it was difficult to understand if the terms used by different researcher 

were describing similar or different phenomenon. Looking for regularities in the design 

process was one way to address this problem. This lead to a proposal of an axiom: 

The foundations of designing are independent of the designer, their situation and what is being 

designed. 

The Function-Behavior-Structure (FBS) ontology addresses this issue by describing all design 

no matter what discipline of design it belonged to. The thee fundamental constructs of the 

FBS ontology, namely, Function (F), Behavior (B) and Structure (S), are defined as follows: 

Function is the teleology of the artefact (“what the artefact is for”). It is ascribed to the artefact 

by establishing a connection between one’s goals and the artefact’s measurable effects. 

Behavior is defined as the artefact’s attributes that can be derived from its structure (“what the 

artefact does”). Behavior provides measurable performance criteria for comparing different 

artefacts. Structure is defined as its components and their relationships (“what the artefact 

consists of”). 

 

 

Figure 2 - FBS Examples (Gero, 2004)  

Professor John S. Gero further developed an extension to the FBS ontology in the form of the 

FBS framework (Gero 1990). The framework basically represents the design process as various 

transformations between the three FBS constructs (Function, Behavior and Structure). 

Transformations from function to behavior and vice versa can be considered as the most basic 

view of designing. Behavior, in this regard can be interpreted as the expected performance to 

achieve the desired function. Upon producing a structure, it is still important to verify whether 

the “actual” performance (based on operating environment and structure) match the 

“expected behavior”. Behavior is therefore separated into two different classes by the FBS 

framework: namely, expected behavior (Be) and behavior derived from structure (Bs). 
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The FBS framework is characterized by eight fundamental transformations or processes:  

1. Formulation R → F, and F → Be 

2. Synthesis Be → S 

3. Analysis S → Bs 

4. Evaluation Be ↔ Bs 

5. Documentation S → D 

6. Reformulation type 1 S → S’ 

7. Reformulation type 2 S → Be 

8. Reformulation type 3 S → F (via Be) 

 

 

 

Figure 3 -  The FBS Framework (Gero, 2004) 

The ability of the framework to describe any instance of designing, irrespective of a specific 

domain or method makes one of the foundations for theory of designing. Experiments to be 

carried out in this research are focused on investigating the cognitive processes of Analysis 

(how designers analyze the “behavior derived from structure”) and Synthesis (how they come 

up with a “structure” for the “expected behavior”). 
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2.1.2 Design Science – A Brief Modern History 

The period from 1920’s to 1960’s was a period of emergence of understanding design as a 

scientific, objective and rational activity. The establishment of Staatliches Bauhaus in 1919 

(Weimar, Germany), as the first school with a design curriculum, is amongst the most 

significant milestones in the field of understanding design. Although it was closed due to the 

Nazi regime in 1933, it eventually led to the establishment of the ‘New Bauhaus’ in US in 1937. 

The ‘New Bauhaus’ then eventually became the foundation of the Institure of Design at Illinois 

Institute of Technology. The following figure shows the chronology of what was considered 

design in research alongside the development in science / industry. 

 

 

Figure 4 - Design Research Chronology (Bayazit, 2010)  

 

Richard Fuller, a technologist from the 60’s believed that problems that could not be addressed 

by politics or economics should be addressed by science, technology and rationalism. For this 

purpose, he christened the ‘design science revolution’ and considered the 60’s as the decade 

for design science. TRIZ (Altshuller’s Theory of inventive problem solving), a forecasting and 

problem-solving tool is perfect example of early design science [8]. The tool was founded in 

Russia during the 1940’s. Eventually in the 1960s, the decade culminated with Herbet Simon’s 

‘The sciences of the artificial’ and his strong plea for the development of a science of design 

in universities. With significant shifts in the field of this research the focus moved to creating 

a design discipline and using design cognition to understand the design process (Cross, 2007; 

Bayazit, 2010). 

2.2 Studying Design Behavior – A Comparison of Different Research Strategies 

The question that fascinates researchers the most is trying to know what is it that designers 

do when trying to solve design problems? The focus is this section is to give a brief description 
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of some the most commonly used strategies that have been used by researchers to answer 

the above question. The four strategies that we discuss are the following: 

- Think-aloud Protocols 

- Content Analysis 

- Process Isolation 

- Situated studies 

 

This will give us a better understanding of how to evaluate neuroscientific experiments, like 

the one carried out in the following chapter. The key similarity among these four strategies is 

that they all consider design as a distinct type of behavior, while they differ on assumptions 

made regarding design. 

 

 

Table 1- Research strategies and their theoretical bias  

 

2.2.1 Think-aloud Protocols  

Think-aloud protocols, as the name suggests, involves participants to think out loud as they 

are performing a set of specified tasks. Participants are asked to say whatever comes into their 

mind as they complete the task. To observe the processes as explicitly as possible, and not 

only the final product, the subjects are required to speak out loud what they are thinking, 

doing, feeling or looking at. 

In a formal research protocol, all verbalizations are transcribed and then analyzed. In a usability 

testing context, observers are asked to take notes of what participants say and do, without 

attempting to interpret their actions and words, and especially noting places where they 

encounter difficulty. Audio and video records of these test sessions are often kept so they can 

be referred to later by the researchers.  

Such strategies are ideal for problems that offer little space for possible solutions. Thus, 

“whenever verbalizations correspond to plausible intermediate states in a processing model 
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for the problem-solving activity, we can plausibly infer that this information is actually used in 

generating the problem solution” (Ericsson and Simon, 1993:171). A common difficulty faces 

in this kind of strategy is regarding the interpretation of utterances. Newell and Simon 

conducted several protocol studies [7] to map out plausible problem spaces that participants 

might transverse while performing a task. The problem spaces help identify some concepts 

that can used as a dictionary to interpret these utterances. Another major criticism of this 

strategy is that verbal data may not be adequate for tracking sequential thought process. 

Think-aloud protocols may misrepresent underlying processes to the extent that subjects 

"sometimes cannot report on the existence of critical stimuli, sometimes cannot report on the 

existence of their responses, and sometimes cannot even report that an inferential process of 

any kind has occurred" (Nisbett and Wilson, 1977:233). 

2.2.2 Content Analysis 

Another widely used research technique is content analysis. There are three major approaches 

for such analysis, namely, conventional, directed and summated. The three approaches differ 

in coding schemes, origins of codes and threats to trustworthiness, while similar in that they 

all use text data content for interpretation. Conventional content analysis derives coding 

categories directly from text data, direct approach uses theories or relevant researches as a 

guide of the codes, while summative analysis uses counting and comparison of keywords, 

followed by interpretation [Hsiu-Fang and Shannon, 2005]. 

The basic idea here is that different concepts get their meaning through links with other 

concepts often inheriting or sharing meanings with other domains. Content analysis aims to 

overcome the limitations of the think-aloud protocols by focusing on the content of the 

thought, particularly on the kind of knowledge representations used in design (Eastman, 

2001:28). The aim is to understand the structure and content of representations often heavily 

relying on qualitative analysis of external reports e.g. verbal data.  Hence content analysis may 

also involve participants saying out loud what they’re thinking as they perform a task. 

Researchers may still do some kind of probing since the idea is to unveil the internal 

representation. So, this kind of strategy also depends on theories for coding, similar to think-

aloud protocols. This also suggests that it would be ideal to use content analysis as 

complementary layer on top of think-aloud protocols instead of using it as a stand-alone 

technique. Both the approaches depend on theoretical models that help us understand of 

what can be considered as a representation and what not. Though content analysis includes 

the measurement of quantitative performance, researchers are still required to make 

assumption, mainly regarding the variables that would be measured (independent/dependent 

or significant/insignificant).  
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2.2.3 Process Isolation 

Process isolation offers another alternative to two protocols explained above. They make the 

use of processes that are isolated from design episodes to understand the underlying cognitive 

processes as well as the representations [Eastman, 2001:26]. The assumption here is that 

designers undertake a host of activities that contribute to the transformation of 

representations in design. These activities include those traditionally studied in cognitive 

science such as analogy (Holyoak, 1983), mental modelling (Johnson-Laird, 1983), simulation 

(Barsalou, 1999), conceptual combination (Wisneiwski, 1997) and conceptual blending (Turner, 

1998). The major difficulty encountered with this approach is that researchers must construct 

tasks that are related to design and have well-defined dependent variables, since researchers 

often try to understand the design behavior by extending existing theories in cognitive science. 

Creating the right task could be crucial when adopting this approach. In Casakin and 

Goldschmidt [1999], for example, the dependent variable was the general quality of design as 

assessed by a panel of experts. Though the quality of design can be of interest, the problem 

with assessing design quality is that it is not a quantifiable variable. In Casakin and 

Goldschmidt's study, design quality may be confounded with variables other than those 

directly related to the analogical processes being studied. Therefore, the study doesn’t really 

lead to clarify underlying cognitive processes, although there is a marked improvement in the 

quality of design by the presence of visual analogs.  

2.2.4 Situated Studies  

Jesper Simonsen in his book Situated Design Methods claims that “all design is situated – 

carried out from an embedded position”. Situated studies considers designers and their social, 

cultural and material contexts as ‘Intact activity systems’ by focusing on activities that relate to 

these contexts (Greeno, 1998). Proponents of this research claim that working bottom up is 

insufficient for this approach since for complex behaviors the interactions may differ 

unpredictably, and hence they require the development and employment of theoretical 

concepts that are specific to the situated behavior.  These studies often focus on one of the 

following two things: the way meaning is produced in situations or the way social context / 

material environment regulate behavior. The assumptions made with such studies depends on 

whether the focus is on the meaning or on the effects of environment on the behavior. In the 

first case, the assumption is that the meaning is created in particular situations and not carried 

in symbols, while in the second case the assumption is that the situation or environment will 

result in specific behavior being exhibited. 

The purpose of the descriptions and comparison of the pros and cons of the above 

approached are intended to give us some context into research methods used for studying 

design behavior. 
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2.3 Cognitive Neuroscience and Design 

Analysis of neurobiological substrates of various cognitive processes is represented by 

cognitive neuroscience. It puts together the various experimental techniques that are used to 

study these substrates, mainly focusing on physiology, psychophysics, electrophysiology and 

functional neuro-imaging. Design research acknowledges the comprehension of design 

cognition as a significant focus of research since it a very complex activity in nature, even 

though typical studies focus on very simple and repetitive processes. Notably, the early stages 

of design are considered to be among the most cognitively intensive in the design process 

(Nakakoji, 2005), resulting in most of the research studies focusing only on the early stages of 

the design process. Cognitive psychology researches, on the other hand, have focused more 

on psychological elements like attention, perception, learning, remembering, speaking and 

reasoning, being the most common amongst them. In design research community, problem 

solving has been one of the widest concerns when it comes to research in design cognition. 

As further justified by Herbert Simon in his book “The Science of the Artificial”, “design is 

inherently computational – a matter of computing the implications of initial assumptions and 

combinations of them”. Hence the consensual notion of design cognitive activity is that 

designers start with ill-defined or illstructured problems in the early stages of design process; 

each problem solver (here, the designer) then constructs its mental representations of design 

problem which are mostly incomplete and imprecise in the beginning (Simon, 1968). It 

becomes clear that design is not normal “problem solving”. Though it was common to use 

concepts of cognitive science to study design cognition, but as Herbert implies that these 

could be inaccurate and partial, to fully analyze and study design cognition it is critical to 

establish the right concepts and structure. 

The complexity of design activity raises a further question of how reliably and to what extent 

do experimental setting allow us to study the relationship between design and brain related 

functions and hence allowing scientific questions to be answered that address that relationship 

of cognitive competences and designing. A further hurdle has been the lack of tools that would 

allow to carry out such researches. Only recently researchers have started to investigate 

problem solving processes using fMRI (Functional Magnetic Resonance Imaging) and focused 

on analyzing differences between ill-defined design and well-defined problem solving tasks 

(Goel & Grafman,2000; Alexiou & al.,2009; Gilbert, & al.,2010). The cognitive neuroscience 

research community is obviously still not at a point where they could tell what and how a 

designer thinks when carrying out a task but we can apply it to analyze the brain activity of 

designers during very specific phases of problem solving. 

2.3.1 Neuroscience Research in Design – The State of the Art 

In order to establish the state of the art in design related neuroscience research, an extensive 

research was conducted and numerous scientific papers were collected based on keywords of 
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interest. These research papers were used to establish the state of the art when it comes to 

the use of neuroscientific tools in design research. The bubble diagram below shows the 

spread of the main research papers according to the keywords and the relationship between 

them. These research papers also included experimental studies from which inspiration was 

drawn for our experiment. 

 

 

Figure 5 - State of the Art - Neuroscientific Research in Design  

2.4 Neuroscience, Creativity and Divergent thinking 

Creativity is often confused with design and though they are not the same, creativity does play 

a huge role in the design process. This section explains creativity in the light of neuroscience 

followed by a review of common results that have been observed in this field of research. Most 

research studies have focused on divergent thinking and its correlation to creativity, hence the 

focus of this section is on the correlation of tasks simulating divergent thinking and the 

corresponding Electroencephalogram (EEG) activity observed. 

Creativity is commonly defined as the ability to produce work that is both original and unique, 

namely novel, and useful within a social context (Fink & Benedek,2012). Playing a significant 

role in the process of inventing something new, creativity is a vital trait of the human character. 

Though the study of other psychological sciences has developed in the past 50 years, research 

that focused on studying creativity have been quite uncommon (Dietrich & Kanso, 2010). Given 

its significance in various disciplines (not only related to science), the subject of creativity has 

gained significant popularity in recent years leading to similar raise of interest amongst 

cognitive and neuro scientists. 

Though Electroencephalography (EEG) has been widely used to study creativity, it still doesn’t 

provide a significant conclusion due to the high variability in results (Arden, Chaves, 
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Grazioplene & Jung, 2010). The main reason being the different approaches that have been 

employed to carry out these experiments and the varying definitions of creativity. 

2.4.1 Complexity in investigating research comparison 

There are several aspects of creativity that make it quite complex to compare existing 

researches. One of the main aspects is the varying definition of creativity. Not only have 

researchers been very vague regarding the definition being investigated, but also being 

characterized differently across different domains contributes to the resulting complexity. For 

example, some see it as cognitive state or event, others consider it as a personality trait, while 

a definition that is skewed more towards the design process relates it to divergent thinking. 

(Fink & Benedek, 2012).  

Another aspect contributing to this complexity is the variation in the type of tasks that have 

been employed to simulate creativity and hence study it. It is debatable as to which tasks 

actually simulate creativity and which do not. This has also led to the categorization of activities 

that are commonly used to study creativity. The categories are: 

- Remote association tasks 

- Insight tasks, and 

- Creative Ideation tasks. 

Remote association tasks usually require the participants to produce something artistic, like a 

story, melody, sketch etc. The most commonly used remote association task is the Remote 

Association Test (RAT). RAT is often used to test human creativity, where participants are given 

three words that appear to be loosely related and they are required to come up with a forth 

word that is somehow related to these three words. These tasks rely on the idea that the most 

original solutions or ideas are not the obvious ones or “remote and far down the associative 

pathway” (Runco & Yoruk,2014).  

Insight tasks, on the other hand, are slightly deceptive and confusing where in order to find 

the solution the problem requires some kind of cognitive restructuring which eventually leads 

to limited or only one “ah-ha!” solution (Runco & Yoruk,2014). 

Creative ideation tasks can be defined by looking at the most commonly used example; the 

Alternate Uses Task (AUT), also known as the Guilford’s Alternative Uses Test (Wilson, Guilford, 

Christensen & Lewis, 1954) were examinees are required to list down as many possible uses 

for a common household object. This problem simulates the typical conditions of divergent 

thinking as it requires the participant to not go towards a single solution, but many different 

solutions employing different pathways. Creativity and divergent thinking are often related, 

even if the results are not always new and uncommon ideas; several tests point towards the 

idea that tasks that simulate divergent thinking can be used to estimate creativity (Runco & 

Yoruk,2014). 
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When considering the use of EEG for such studies, there are many different techniques that 

can be employed to study the activity of the brain. For very short timed tasks, event related 

potential is a widely used method employed on EEG data. Other techniques include studying 

the overall change in power in the overall brain or just certain regions of the brain. 

Furthermore, EEG data can be broken divided into specific bands and the above-mentioned 

techniques can be employed only to study these specific frequency ranges of EEG data. 

Given, so many variable factors regarding definitions, experimental procedures and measures 

being used to carry out such studies, it is still not possible to compare and reach structured 

and reasonable results (Fink & Benedek,2012).  

2.4.2 Divergent thinking 

Divergent thinking is described as the process or method of thinking employed to arrive to 

many possible solutions to a given problem. Guilford defines it as the brain “going off in 

different directions” during an act of creativity (J. P. Guilford,1959). He used the terms of 

convergent and divergent thinking in an attempt to differentiate creative and non-creative 

processes. Many researchers associate the entire creativity process as divergent thinking, but 

Guilford describes that in order to come up with a unique final solution, the brain also needs 

to evaluate all the possible solutions and pick the best one (J. P. Guilford, 1950). 

Just like creativity, studying divergent thinking with neuroscientific methods has many 

restrictions. Just considering EEG; the data generated during an EEG recording session have 

very high frequencies and having a long session would result in huge data sets with highly 

sensitive and varying data, but on the other hand researchers suggest that creativity tasks 

shouldn’t be times as the added factor of time can act as a distraction for the participant and 

influence their creativity levels. 

2.5 Brain Research Technologies and their relation to Design Research 

Significant advanced in neuroscientific tools in recent years have widened the bottlenecks 

present in design research. The main challenge now is to be able to create reliable 

experimental settings that allow examination of interrelations between design activity and 

design cognition. The choice of tools used depends on the kind of experiment being 

conducted and more significantly on the research questions posed. This section provides a 

brief description of the main technologies available at the moment and their advantages and 

limitations in relation to design research.  

2.5.1 Functional Magnetic Resonance Imaging – fMRI 

fMRI measures brain activity by detecting changes associated with blood flow. In simple words, 

when an area of the brain is active it results in an increased amount of blood flow to that area. 

This coupled relation is what this technique relies on. The results are in the form of a detailed 
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picture of various brain areas and the oxygen they use over time. Traditional fMRI experiments 

shed light on the following types of questions: 1) Which brain areas are activated in task A 

compared to task B? 2) Do individuals in group X and group Y have different brain areas 

activated by task A and task B?  

The obvious limitation of this technology for studying design is that participants will be 

restricted in cylindrical tubes resulting in limited movement and a high level of distraction from 

the task being carried out. Another drawback is that fMRI scanners are very expensive and can 

only be found at hospitals or high-level research labs, making it un-portable and unsuitable 

for smaller experiments. Hence the high level of physical and time constraints lead to a 

complex process of designing and planning tasks that are simple to carry out and still provide 

significant results for further analysis.  

 

Figure 6 – Functional Magnetic Resonance Imaging  

2.5.2 Near Infrared Spectroscopy – NIRS  

This is an optical imaging technology that utilizes changes in the absorption and scattering 

properties of light as it travels through brain tissue. When a brain tissue is active, more oxygen 

travels to that area prompting changes in the properties of light absorption and scattering 

(Gratton et al.,2001). This kind of technology is portable and does not require a laboratory 

facility making is suitable for design experiments where natural working environment is of 

great importance. 

2.5.3 Electroencephalography – EEG 

Electroencephalography is possibly the oldest brain research technology employed in research 

experiments. The portability and temporal accuracy on very small-time scales makes it the 

ideal tool for experiments that do not require a complex laboratory setting. EEG signals are a 

consequence of electrical neural activity and are picked up from the scalp that is the surface 

of the head. Event related potentials (ERPs) are averaged fragments of EEG signal indicating 
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brain activity that is temporally related to an event e.g. the appearance of an image or the 

reproduction of a sound. Visual, somatosensory and auditory components (peaks) of ERPs 

have been observed, and some features of their relationships to the cognitive functions of 

perception, memory and attention have been identified. Previous research has revealed 

activation of the brain’s sensor motor areas in response to the stimuli of seeing other people 

working (Borghi & Cimatti, 2010). An obvious disadvantage in contrast to fMRI is that with EEG 

it is difficult to identify active brain areas in detail (Seitamaa-Hakkarainen, 2014). 

 

Figure 7 – Electroencephalography – EEG 

 

2.5.4 Measures in EEG 

As mentioned before, EEG activity provides the possibility of employing several approaches 

that can be used to measure activity of the brain. Past studies have used; spectral power 

analysis to measure the variation in frequencies in the overall brain or only specific major 

regions, Event-related potential (ERP) to study the effect of small time range events on the 

EEG data, Independent Component Analysis (ICA) to decompose data into several components 

(Physical, Eye, Muscular, Noise or Brain/cognition related) and then carry out spectral or ERP 

analysis are amongst the most common approaches that have been used. 

EEG signal frequency range lies between 1 Hz and 100 Hz and the range can be further 

classified into smaller frequency bands, namely;  

- Delta (1 – 4 Hz) 

- Theta (4 – 8 Hz) 

- Alpha (8 – 12 Hz) 

- Beta (13 – 25 Hz) 

2.5.5 Review of researches employing EEG to study divergent thinking 

Researchers have often employed EEG to study divergent thinking. Most of the studies have 

focused mainly of the alpha band as it has been frequently associated with divergent thinking 
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or creativity. Most of these studies further divided these frequency bands into smaller sub-

bands, for example the alpha band can be further classified into lower (~ 8-10 Hz) and upper 

alpha (~ 10-12 Hz) bands. The following table reports a review of researches that employed 

EEG to study divergent thinking: 

STUDY BANDS SUB-

BANDS 

FUN. 

CON. 

DESIGN COVARIATE 

Bazanova & Aftanas, 2008 α; β; γ; θ YES NA TR; WTC NA 

Danko et al., 2009 α; β; γ YES NA TR; BTC NA 

Fink & Neubauer, 2006 α YES NA TR Verbal IQ; Gender 

Fink & Neubauer, 2008 α YES NA TR; BTC Introversion/Extro

version 

Fink et al., 2006 α YES NA TR; BTC DTTT 

Fink et al., 2009 α YES NA TR; BTC NA 

Grabner et al., 2007 α YES PHASE TR; WTC NA 

Jaušovec, 2000 α YES CO TR IQ; TTCT 

Martindale & Hasenfus, 

1978 

α; - - - WTC; BTC AUT; RAT 

Martindale & Mines, 1975 α; - - - WTC; BTC NA 

Martindale et al., 1984 α; - - - WTC; BTC AUT; RAT 

Mölle et al., 1999 α; β; δ; θ NA NA TR; BTC NA 

Razumnikova et al., 2009 α; β; θ YES CO TR; BTC NA 

Razumnikova, 2005 α; β; θ YES CO TR; WTC Gender 

Razumnikova, 2007 α; β; θ YES CO TR; WTC NA 

Shemyakina & Danko, 

2007 

α; β; δ; θ YES CO TR; WTC NA 

Jauk et al., 2012 α YES NA TR; BTC NA 

Fink, Schwab, Papousek, 

2011 

α YES NA TR; WTC NA 

Benedek et al., 2014 α; β; θ NA NA TR; WTC NA 

Note:     AUT = Alternate Uses Task; BTC = Between Task Comparison; CO = Coherence; DTTT = Divergent Thinking Task Training; 

FUN. CON. = Functional Connectivity measure; IQ = Intelligence Quotient; NA = Not Avaiable; NS = Non-Significant difference; RAT 

= Remote Associates Test; TR = Task-Rest Comparison; TTCT= Torrance Test of Crative Thinking; WTC = Within Task Comparison; α 

= Alpha Band; β = Beta Band; γ = Gamma Band; δ = Delta Band; θ = Theta Band. 

 

Table 2 - Review on EEG and divergent thinking studies 
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- Few of these studies did not find a significant variation in alpha signal (Danko, 

Shemyakina, Nagornova, & Starchenko, 2009; Martindale & Hasenfus, 1978; 

Shemyakina & Danko, 2007).  

- Among the other frequency bands, beta was the only one with some evidence of 

correlation with creativity tasks; most reported an increase in activity (Danko et al., 

2009; Mölle, Marshall, Wolf, Fehm, & Born, 1999; Razumnikova, 2005; Razumnikova, 

2007) while only one study reported decrease (Shemyakina & Danko, 2007). 

The following table provides summary of previous researches that analyzed Alpha band power 

changes in different regions of the brain.  

ALPHA BAND POWER CHANGES IN LOBES  

STUDY Frontal Temporal Parietal Occipital HEMISPHERE 

Bazanova & Aftanas, 2008 INC NA ERS ERS NA 

Danko et al., 2009 NS NS NS NS NA 

Fink & Neubauer, 2006 ERS ERS ERS ERS NS 

Fink & Neubauer, 2008 INC INC INC INC RIGHT 

Fink et al., 2006 ERS ERS ERS ERS NS 

Fink et al., 2009 ERS ERS/ERD ERS/ERD ERS/ERD RIGHT 

Grabner et al., 2007 ERS ERS ERS ERS RIGHT 

Jaušovec, 2000 ERS ERS/ERD ERD ERS NS 

Martindale & Hasenfus, 1978 NS - - - NS 

Martindale & Mines, 1975 INC - - - RIGHT 

Martindale et al., 1984 INC - - - RIGHT 

Mölle et al., 1999 NS NS INC NS NS 

Razumnikova et al., 2009 ERD ERD ERD ERD NS 

Razumnikova, 2005 NS NS NS NS NS 

Razumnikova, 2007 NS ERD ERD ERD LEFT 

Shemyakina & Danko, 2007 NS NS NS NS NA 

Jauk et al., 2012 ERS ERD ERD ERD RIGHT 

Fink, Schwab,Papousek, 2011 ERS ERS NS NS RIGHT 

Benedek et al., 2014 ERS ERS ERS ERS NA 

Note:     ERD = Event Related Desynchronization; ERS = Event Related Synchronization; HEMISPHERE = Hemisphere 

with stronger power/synchronization; INC = Increase in power; NA = Not Available; NS = Non-Significant difference. 

Table 3 - Evidence in Alpha Band 

Majority of these studies show an increase in Alpha activity or event related synchronization 

whereas few show a decrease or dyssynchronization. Half of them also identify the hemisphere 

with higher activity with majority showing higher activity in the right hemisphere. The 
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relationship between higher activity in one hemisphere is often attributed to the dominant 

side of the person. The results of the review also suggest so as majority of people have the 

right side as the dominant one. 

2.5.6 EEG Alpha Power and Creativity 

As can be seen from the results reported in the above tables, most researches have consistently 

shown a relationship between alpha activity and creativity related tasks, but at the same time 

in can be seen that they are not consistent. Researches that show significant variation in alpha 

power usually report the activity being higher in the frontal and posterior regions of the brain, 

something that is also coherent with medical researches; that suggest alpha activity usually 

generating in these two lobes. 

Some studies, like (Molle, 1999), have also tried to study the difference in activity during 

divergent thinking and convergent thinking tasks; providing further evidence that alpha 

activation is higher in divergent thinking tasks as compared to convergent thinking ones. 

Studies have also shown some relationship between the level of creativity and corresponding 

power of alpha activity; tasks demanding more creativity and originality usually result in a 

stronger alpha activity and vice versa (Fink, Benedek, Grabner, Staudt, & Neubauer,2007; Fink 

& Benedek,2012).  

Other studies (Razumnikova et al., 2009; Razumnikova, 2007) reported alpha 

desynchronization and the reason could be dependent on the relatively long reference period 

adopted by these studies: 5 minutes of rest with eyes closed, while in other studies reference 

period do not exceed two minutes. Since the beginning of EEG technique in 1930s by Hans 

Berger, it was evident the increase in amplitude of alpha wave when individuals have their eyes 

closed compared to when they have their eyes open. Since resting periods are usually used as 

a base-mark to evaluate the activity during tasks, having a high alpha activity in the resting 

phase (due to closed eyes) wouldn’t provide credible results as the comparison would lead to 

an overall low alpha activity when the participants were carrying out the tasks (hence having 

their eyes open). 

Other studies have also carried out comparisons between subjects based on their individual 

characteristics or qualities; such as creative vs less creative people (Jausovec,2000), male vs 

female participants (Fink & Neubauer, 2006), and extrovert vs introvert participants (Fink & 

Neubauer, 2008). These basically involve clustering the participants based on the chosen 

criteria of the experiment and requiring the subjects to carry out tests.  

Another category of these researches has investigated how training, creativity enhancing or 

other cognitive stimuli could influence the activity of the brain (Fink, Grabner, Benedek, & 

Neubauer,2006; Fink, Schwab, & Papousek,2011). For such experiments participants had to 
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carry out two tests, one before the training or stimuli and another after it. These experiments 

also conclude that cognitive stimuli enhances the alpha activity of majority of participants. 

Summing it up; although there is still no solid evidence and significant overlap between the 

results of these experiments, we can still witness at least some level of relationship between 

alpha activity and creativity.  

2.6 The Research Question and the Choice of Tool 

The FBS framework discussed earlier and others like it are developed through decades of 

research consisting of numerous protocol studies and elaborate coding schemes whose 

validity and reliability, according to some, is debatable at best. Along with comparing our 

experimental results to those reported in Table 2 and 3, we also want to investigate whether 

these cognitive processes can be identified using the latest neuroscience technology paving 

way for further research that can verify or better substantiate such frameworks that attempt 

to describe the design process. Since design activity is a complex task we have decided to 

focus on two of the cognitive processes, namely Analysis and Synthesis, and see if it’s possible 

to recognize and distinguish them using neuroscience technology? Professor Pirita Seitamaa-

Hakkarainen in her paper “How can neuroscience help understand design and craft activity? 

The promise of cognitive neuroscience in design studies” outlines the feasibility of different 

neuroscience technologies for design research. 

After having evaluated carefully the potential and the feasibility of different neuroscience 

technologies with respect to design research, we decided to use EEG as our choice of 

technology for this experiment. The biggest advantage of EEG over other methods is 

outstanding temporal resolution allowing us to observe the neural activity at the level of 

milliseconds. Such temporal resolution is the best approximation for neural events. After 

having decided to use EEG as our preferred technology for this experiment, we evaluated 

various options for the EEG headsets available off the shelf in the market (See Appendix E). 

Some of the things that were taken into account were no. of channels, sensor frequency, 

battery life and software support. 
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Figure 8 - Pros and Cons of Neuroscientific Methods for Design Studies (Seitamaa-Hakkarainen, 2016) 

 

Figure 9 - Shortlisted Headsets for the Experiment 

 

After an investigation, it was concluded that the Emotiv Epoc+ was the only research grade 

headset available in the market and preferred by the research community [9]. The Emotiv 

Epoc+ is a 14 channel wireless EEG headset designed for contextualized research and 

advanced brain computer interface applications. It comes with the Pure EEG software that 

allows access to dense array high quality raw EEG data. 
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Figure 10 - Scalp Locations and Specifications - Emotiv EPOC+ 

2.6.1 Research Question  

Do engineers exhibit distinct EEG patterns while engaging in prototypical tasks of Analysis and 

Synthesis? 
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3. EXPERIMENT 

 

An experiment was designed to answer our research question and validate the usability of EEG 

for studying the design process. Three different tasks were constructed, one of which was 

assumed to involve the cognitive function of analysis and the other two of synthesis. A typical 

problem involving analysis comprises of identifying all relevant factors to a given situation and 

breaking a subject into parts to better understand the problem. While synthesis involves 

finding partial solutions among feasible alternatives and possibly integrating them into one 

single form. EEG brain activity of engineering students was recorded while they carried out 

tasks simulating the cognitive conditions of the Analysis and Synthesis phases of the design 

process. The experiment was conducted in the form of EEG recording sessions (corresponding 

to the number of participants); each divided into two resting phases and three cognitive 

phases. Collected raw data was then cleaned and classified for further analysis. 

3.1 Participants 

3.1.1 Population 

The target population consisted of Master Level Engineering students that had pursued their 

bachelor in any of the engineering disciplines that fall under the major branch of Mechanical 

Engineering. The accessible population was then filtered and shrunk down to students of 

Polytechnic University of Turin that met the mentioned requisites, were willing to participate 

and gave consent to carry out the EEG recording session. 

The purpose of considering only Master level students was to ensure that the level of expertise 

and ages of the participants were similar, making it possible to control the level of 

homogeneity of the selected sample. To further increase the homogeneity only male students 

were considered. 

3.1.2 Sample size 

A very common question in neuro-research experiments is regarding the number of subjects 

required to obtain reliable results. Past researches show a huge variance in the number of 

participants, going from as little as 5 to up to 400 participants. According to a systematic 

review of 100 randomly chosen EEG studies; 0 out of 100 reported sample size calculations 

(Larson & Carbine, 2017). Absence of such information hinders accurate determination of 

sample sizes for such researches. 

Though traditional brainwave collection technologies use between 100-150 subjects to obtain 

consistent results, Dr Stephen F. Sands argues in his paper that the increased sensitivity of EEG 

measures requires fewer participants to obtain the same level of reliability (Sands, 2009). To 

formally answer this question, he carried out a power analysis to statistically test the number 



29 
 

of participants that would be required to reach an acceptable threshold, such as 95% likelihood 

of being correct. The power analysis was carried out using the Neuro-Engagement-Factor 

(NEF) (a Z-score derived from the electrical activity of the brain) to show that approximately 

30-40 subjects are required to have a 1% chance of error. The smallest pool of subjects that 

showed some level of significance (5% chance of error) was approximately 4. 

One possible approach would be to carry out a sequential analysis. In this case, the sample 

size is not fixed in advance and data is evaluated as it is collected, while further sampling is 

stopped as soon as significant results are observed. Considering the standardized nature of 

the experiment, it is possible to perform a sequential analysis in the long-term if the 

experiment is repeated in the future by other researchers. 

Due to time limitations and infeasibility of carrying out the experiment on a large scale, a 

sample size of 12 was selected, which, according to Dr Sands analysis would provide results 

with lower than 5% chance of error. 

3.1.3 Sample 

A sample of 12, male, masters level engineering students, ageing between 23 and 27 years old 

(Average = 25.6, Standard Deviation = 1.39) were selected from the accessible population to 

participate in this research. All participants were healthy individuals, with no obvious disorders 

that could affect the recorded data. Due to huge amounts of distortion and noise, data from 

3 of the 12 recording sessions were rejected during the data preparation and cleaning process. 

After cleaning the data and extracting epochs for each task, we obtained 27 data sets in total 

(3 for each subject) but 7 of them had to be excluded from the final analysis. The process of 

rejecting these data sets in further explained in detail in the next chapters. 

The experiments were conducted considering the participants routine to ensure they were not 

tired, stressed or hungry during the recording sessions. The participants were informed about 

the experiment in detail and asked to read and sign a consent form before beginning the 

session. 

3.2 EEG Apparatus 

3.2.1 EMOTIV EPOC+ 

The EEG was measured using the EMOTIV EPOC+; a high resolution, multi-channel, portable 

EEG system designed for practical research applications. The EPOC + features 14 channels, 

plus 2 reference channels, offering optimal positioning for accurate spatial resolution and 

ensuring ‘whole brain’ measurement. 

The 14 electrodes are located at positions (according to the international 10-20 locations): AF3, 

F7, F3, FC5, T7, P7, O1, O2, P8, T8, FC6, F4, F8, AF4 and the reference electrodes are located at 

positions P3/P4 locations in the CMS/DRL configurations. The electrode sites are labelled with 
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a letter and a number. The letters refer to the area of the brain under the electrode e.g. F – 

Frontal Lobe and T – Temporal Lobe. Even numbers denote the right of the head and odd 

number the left side. 

 
Figure 11 – EMOTIV EPOC+ channels (International 10-20 locations) 

3.2.2 EMOTIC Xavier Pure.EEG 

The EPOC+ allows recording raw EEG data using its subscription-based software, the Xavier 

Pure.EEG. The software collects data packets via a wireless USB device and shows real time 

display of headset data streams including Raw EEG, motion data, data packet acquisition or 

loss and sensor contact quality. It also offers recording to be stored on their online cloud 

storage and playback or export at any time.  

The software also allows to customize and view frequency data of recorded sessions with 

automatic FFT (Fast Fourier Transformation) and power band graphs.  

During the experiment, headset settings were kept at default; recording at a sampling rate of 

128 Hz and 14-bit resolution. The headset has an internal sampling rate of 2048 which is 

filtered and down sampled to 128 per second per channel.  
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Figure 12 – EMOTIV XAVIER Pure EEG real time display 

3.3 Experiment Procedure 

3.3.1 Environment 

The recording sessions were conducted in a silent and comfortable workspace with minimum 

interference and no audio or visual distractions. Though the sessions were carried out over a 

period of one month, the room environment was kept constant for each session. A desk and 

chair was arranged on one corner of the room for the participant and an LCD screen was 

positioned at a comfortable reading distance, to display the tasks.  

3.3.2 Pre-Experiment Protocol 

The EEG devices were charged and hydrated half an hour before each recording session. An 

instructional presentation was prepared to provide a brief description and example of each 

phase, as well as the general do’s and don’ts to be followed during the experiment. The 

participant was provided with a pen and some plain A4 sheets to express their solutions. To 

ensure a consistent connection, the EEG recording system was prepared and fitted on the 

participant and left for some time at the beginning of the instructional presentation. Once the 

experiment details were clear to the participant and all their questions had been answered, 

they were asked to read and sign a consent form. After ensuring that all EEG sensors had 

established proper connection, the coordinators then proceeded to start the experiment. 

3.3.3 Recording Session 

A timed power-point presentation was used to guide the participant through the recording 

session. The resting phases, tasks and transition phases were organized in a consistent and 
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orderly manner. This ensured that the collected raw data for each participant could be easily 

divided into the relevant sections for further analysis. The following diagram shows a complete 

timeline of how each session was organized: 

 
Figure 13 – Recording Session Timeline 

The session began with a welcome screen followed by two resting phases of 60 seconds each; 

one with eyes open and one with eyes closed. A bell was used to signal the end of the ‘eyes 

closed’ resting phase. The data recorded during the resting phase would serve as a baseline 

to evaluate the data during the cognitive phases. 

At the end of each task, a 30 second waiting screen was displayed. This only served as a 

transition phase between tasks, allowing participants to stop thinking about the previous 

activity and therefore avoid any overlap of cognitive phases. 

Throughout the recording sessions, the experiment coordinators monitored the participant’s 

behaviour and kept note of possible actions or disturbances that could possibly affect EEG 

data – all the while, making sure not to cause any disturbance to the participants. Notes taken 

during these sessions were later used to remove segments of un wanted data. 

3.4 Tasks 

The tasks were chosen after carefully considering that they simulate the cognitive conditions 

exhibited during the Analysis and Synthesis phases of the design process. Three tasks were 

chosen; one for Analysis and two for Synthesis, which would not only allow to evaluate the 

differences in wave patterns between analysis and synthesis but also to evaluate possible 

similarities between the two synthesis tasks.  

All three tasks were kept rather simple since the aim is not to mimic an actual design process 

but to encourage participants to think in a different way for each problem. The simplistic 

nature of the tasks also meant that the time limit for each was rather short so that participants 

do not get bored and lose their attention from the task on-hand.   



33 
 

3.4.1 Task 1 – ‘What Bothers you?’ problem – Analysis Phase 

The analysis phase is described as identifying all relevant factors to a given situation and 

breaking a subject into parts to better understand the problem. This is also sometimes termed 

as the ‘problem definition phase’. 

In task 1 participants were asked to write down and define all the problems related to the use 

of public transport.  The participants were specifically asked to identify, clarify and define but 

not solve the problem. They were given three minutes for this task. 

This exercise led the participants to identify a list of problems (that require solutions) caused 

or related to the use of public transport, simulating the analysis phase of the design process. 

3.4.2 Task 2 – Mathematical Problem with many possible solutions – Synthesis Phase 

The synthesis phase is described as finding partial solutions among feasible alternatives and 

possibly integrating them into one single form. It is also known as the scheme of generating 

possible ways that a product will work. 

Task 2 is a common mathematical puzzle where one is given five numbers and asked to use 

all five numbers and any mathematical operators to make up another given number. 

Participants where given the numbers 2,3,5,10 and 24 and asked to make the number 120. This 

problem has many solutions, for example: (10-5)*24*(3-2) = 120, [(3*24)+(5*10)]-2 = 120,  

24^(3-2)*(10-5) = 120 and so on. 

Participants were given 5 minutes for this problem during which they tried to use different 

combinations of numbers and mathematical operators to achieve the required solution. 

Though not all the participants succeeded, they realized the need of coming up with partial 

solutions that can then be combined to make the number 120. This kept them engaged in 

conditions that closely simulate the synthesis phase for the complete 5 minutes.  

3.4.3 Task 3 – Guilford’s Alternative Uses Test – Synthesis Phase 

In the Alternative Uses Test (Wilson, Guilford, Christensen & Lewis, 1954) examinees are asked 

to list down as many possible uses for a common household object. During the experiment, 

participants were given 3 minutes to do so for a newspaper.  

This task simulates the synthesis phase by encouraging participants to generate the possible 

ways they can use this object. 

3.5 Raw Data – Output 

Raw data collected was stored by the Pure.EEG software in EDF format, a standard binary 

format, that is compatible with many EEG analysis programs such as EEGLab. The files can also 

be exported to CSV formats allowing to view and analyse them using Excel and other software. 
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The following screenshot gives an example of how the Raw data looks like when viewed on 

Excel in CSV format.   

 

 
Figure 14 - Raw Data CSV Format 

Since the sessions were recorded at a sampling rate of 128 per second, each row corresponds 

to 1/128 second of data i.e. one data sample. Successive rows correspond to the next data 

sample, meaning that one second of data is stored on 128 successive rows. 

3.5.1 Data Description: 

The first column acts as a counter that can be used as a time base. It runs from 0 to 128 for 

corresponding to the data samples recorded in each second. 

The second column is flag to indicate if a data packet was dropped during the recording 

session. Flag = 0 means that the data was good. 

Each column from C to P correspond to locations of individual sensors, in the order: AF3, F7, 

F3, FC5, T7, P7, O1, O2, P8, T8, FC6, F4, F8, AF4. The numerical values under these columns 

correspond to the recorded electrical activity from each sensor. It is the measure of voltage 

fluctuations within the neurons of the brain and is recorded in Micro-Volts (uV). 

Columns after P contain other information such as sensor contact quality, gyroscopic 

measures, markers etc. 

The file also contains a single line in the beginning referencing to information for the rest of 

the file. This includes title, recording time and date, sampling rate, and other labels. 

3.5.2 DC Offset 

Raw EEG data is stored directly in these files as floating-point values; the values are directly 

converted from the unsigned 14-bit ADC output from the headset. Since the floating DC level 
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of the signal occurs at approximately 4200 uV, this means that all negative values are 

transmitted as positive values less than the average level, and positive values are transmitted 

as positive values greater than the average. 

It is important to note that before applying any kind of analysis on this data, it is necessary to 

remove the DC offset. The simplest approach is to simply subtract the average from the entire 

data, but this is a very inaccurate method. Ideally one should apply a high pass filter that 

matches the characteristics of the electronics. While another method is to apply filters using 

Matlab, that can track the background level and subtract them. 
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4. DATA PREPARATION AND INDEPENDENT COMPONENT ANALYSIS (ICA) 

 

This chapter acts as a step by step guide regarding the tools and processes used to clean the 

data and prepare in for analysis. The objective of this part of the thesis is not only to prepare 

data that can help test our hypothesis but to also layout the guidelines for anyone interested 

in furthering related research. 

4.1 EEGLAB – MATLAB Toolbox 

EEGLAB is a MATLAB toolbox for processing data from electroencephalography (EEG), 

magnetoencephalography (MEG), and other electrophysiological signals. EEGLAB allows 

implementing various kinds of analysis, such as independent component analysis (ICA), 

time/frequency analysis, artefact rejection and several possibilities of visualizing data in 2D 

and 3D. It allows importing data in several different binary formats, executer data cleaning 

algorithms, extract event related epochs and perform the above stated analysis. Artefactual 

ICA components may be subtracted from the data, and components representing only brain 

activity may be further analysed. The toolbox also allows creating studies for several subjects 

in different conditions or to cluster the independent components that were obtained using 

ICA. 

 

 
Figure 55 - EEG Toolbox 
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4.2 Data Preparation 

In this section of the chapter, the steps are presented to prepare the raw data from Emotiv 

EPOC+ to be further processed in the EEGLAB toolbox. For the sake of this section, raw data 

from one subject of our experiment is used to explain the steps performed to prepare it for 

further analysis. 

4.2.1 Importing Emotiv EPOC+ Data into EEGLAB 

The computer software that comes with the band (EMOTIV Xavier Pure EEG) exports the 

recorded data in (.edf) and (.csv) file formats. This comma separated values file format can be 

seen in figure 16. This file contains the data from all 14 sensors (channels) of the headset along 

with several other columns corresponding to data point serials, gyroscope data, data transfer 

quality, markers and timestamps. We are mainly interested in the data from the 14 channels 

which are 128 values recorded per channel per second. We open this .csv file in Matlab and 

import only the columns corresponding to the EEG channels. This will be imported as a table 

typically under the name of “Untitled”. Next we convert this table into an array and then 

transpose it. Simply because EEGLAB takes an array as an input where rows correspond to the 

channels and the columns correspond to EEG values. Following is the short script for this 

procedure: 

array = table2array(Untitled); 

eegarray = array.’ 

Now we have an array (matrix) of nXm dimension where n is the number of channels, 14 in our 

case, and m is the number of recordings. For us this is around 118912 because we recorded at 

128 Hz and the experiment lasted around 15 minutes. This array can now be imported into the 

EEGLAB as a dataset. 

File > Import Data > Using EEGLAB functions and Plugins > From ASCIII/Float File or 

Matlab Array 

 
Figure 16 – Importing EEG Data 
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Specifying the Matlab variable name and the sampling rate, the data can be imported into 

EEGLAB. 

4.2.2 Setting up Channel Information 

The next step is to enter the channel information so EEGLAB knows which column of EEG data 

values corresponds to which point on the scalp. Fortunately, the Emotiv EPOC+ adheres to an 

internationally recognized method to describe and apply the location of scalp electrodes in 

the context of an EEG test or experiment called the International 10-20 system as shown in 

Figure 17. We know from the raw data files the sequence in which the electrodes correspond 

to the 14 columns of the .csv file. The sequence is as follows: AF3 F7 F3 FC5 T7 P7 O1 O2 P8 

T8 FC6 F4 F8 AF4. Now that we have these codes we can look up the coordinates that describes 

the position of each of those electrodes on the scalp and input them into EEGLAB. EEGLAB 

takes in this information in a very specifically formatted .txt file detailing the coordinates of 

these channels on the scalp. 

 

 
Figure 17 – International 10-20 system 

 

These coordinates are easily available on the web and need to be put into a structure as shown 

in the picture below. 
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Figure 18 – EEG Channel Coordinates 

This file can then be imported onto the dataset that was imported earlier. This file of course 

must be made only once and can be used for multiple datasets.  

Edit > Channel Locations > Read Locations 

4.2.3 Adding Events to Dataset 

Once the dataset and the channel locations are loaded into the EEGLAB, one can start adding 

more information onto the dataset that is specific to ones’ experiment. In our case, these 

events are the markers that signal the beginning to different phases of the experiment. The 

markers / events in our recording are detailed on a timeline in Figure 13. We will now add 

these events onto our data. As with channel information, events also need to be codified and 

put in a specific structure in order to be imported onto the dataset. When adding events onto 

the dataset, there are two obligatory pieces of information that one must input which are 

“Latency” and “Type”. More variables can be added as well of course. We codified our events 

as follows:  

Latency Type Description 

20 ES Experiment Start 

30 RP1S Resting Phase 1 Start 

60 RP2S Resting Phase 2 Start 

90 W1S Wait 1 Start 

120 T1S Task 1 Start 

300 W2S Wait 2 Start 

330 T2S Task 2 Start 

630 W3S Wait 3 Start 

660 T3S Task 3 Start 

840 EE Experiment End 

Table 4 Event Latency Parameters 
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The experiment was always started 20 seconds after the start of the 

recording session for it to stabilize. These were prototypical markers that 

correspond to our experiment.  

These were obviously finetuned for subjects with some variation in 

recording time. These variations were noted during the recording sessions 

(See Appendix F). This information was again put in a .txt file in the structure 

as shown in the figure to be mapped onto the dataset.  

 

File > Import Event Info > From Matlab Array or ASCI II File 

 

It is important to describe the heading names in lowercase and indicate the number of rows 

dedicated for the headings as shown in the figure below. 

 
Figure 19 - Adding Events EEGLab 

4.3 Data Cleaning 

Raw EEG data usually contains lots of noise which can affect the analysis procedure resulting 

in unreliable results. The noise is usually due to outside electromagnetic interference (that is 

difficult to shield off), bad channels or moving sensors during the recording process. It is a 

critical step particularly for average referencing, because the averaging process considers the 

signal of all channels. Since any interference can cause huge distortions in the data, average 

referencing before cleaning that data will result in the complete data set being skewed towards 

bad data. 

There are many methods of cleaning raw data, including manual approaches by scrolling 

through each channel and removing distorted data. Manual approaches are not very desirable 

as it is difficult to spot all bad data by the human eye and it leaves a previously continuous 

data with interruptions. Researchers these days use sophisticated algorithms that can detect 

Figure 6 - Event Codes 
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bad signal and channels while maintaining the original length and continuity of the dataset. 

The algorithm used for our research comes in the form of the cleanraw_data( ) EEGLab plugin. 

4.3.1 Cleanraw_data( ) – EEGLab Plugin 

Christian A. Kothe from the Technische Universität Berlin wrote this algorithm as a plugin for 

the EEGLab Toolbox which removes non-stationary high variance signals from EEG and 

reconstructs missing data using a spatial mixing matrix. It uses very robust calibration statistics 

to minimize any effect of artefacts. The basic idea of this algorithm is that since EEG is highly 

co-related it can estimate content of one channel based on the content of its neighbouring 

channel. The same works for not only one channel but a linear combination of multiple 

channels. 

This method is more commonly known as Artefact Subspace Reconstruction (ASR) method, 

which basically involves extracting clean sections of the existing data using calibration statistics 

over 1-second windows of data and calculating the probability that a signal is due to an 

artefact. It then separates the high amplitude signals (potential artefact components) and 

classifies each component as high variance or nominal variance and reconstructs the high 

variance content using content from nominal variance components. 

After installing the cleanraw_data( ) plugin onto the EEGLab toolbox, datasets can be 

individually opened and cleaned using the algorithm. 

Tools>Clean continuous data using ASR 

The recommended settings for the algorithm are the default ones, as shown in the figure 

below. 

 
Figure 20 - Data Cleaning parameters EEGLab 

The end of the cleaning process is followed by a summary of the data that was rejected. The 

figure below shows a small section of one of the data sets that was cleaned using the plugin. 

The red trace shows the data channel scrolls before the process while the blue trace shows the 

data channel scroll after the cleaning process. 
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Figure 21 - cleanraw_data() before and after 

As explained, the process also removes bad channels. This is a critical step before the data 

averaging process as even the presence of 5-10% of bad channels will lead to noise in all 

channels as it considers average of all channels, good and bad. 

Removal of bad channels may lead to potential bias in the averaging process. For example, if 

0 channels were rejected from the right hemisphere and 0 from the right, the average bias will 

be towards the right. Hence the last step before re-referencing the data is to interpolate the 

electrodes. 

As mentioned in chapter 3, after running the data cleaning algorithm 3 of the 12 data sets 

were rejected. The data cleaning algorithm rejected more than 7 of the 14 channels for 

participants no. 1, 9 and 11, while for other participants no more than 2 of the 14 channels 

were rejected which could be easily reconstructed using electrode interpolation. 

4.3.2 Re-referencing the Data 

EEG voltages recorded by each electrode or channel are relative to what is termed a reference 

channel or a common channel. Often these reference channels are placed on the mastoids 

since they are relatively closer to the other channels and experience lesser electrical signal 

from the brain (for example, TP10 in the 10-20 System, the electrode coloured red in the 

picture below). Generally, these are placed on both sides of the scalp symmetrically in order 

not to generate a bias in the data. As a rule of thumb, reference electrodes are chosen to be 

as far away as possible from the electrodes of interest. There is no best position for a reference 

electrode. Some researchers claim that a non-scalp reference electrode (nose, knee etc.) is a 

better choice but such claims still lack scientific evidence. EEGLAB allows you to re-reference 
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the data. Our headset uses two fixed reference electrodes (P4 and P3) but we have decided to 

re-reference the data to what is called “average reference”, a practice widely advocated by 

researcher in the field. The idea rests on the fact that the outwards positive and negative 

currents summed across a sphere (assumed to be electrically isolated) will sum to zero (Ohm’s 

law). 

 
Figure 22 - Average Referencing 

For example, in the figure above a tangentially-oriented electrical source is associated with a 

positive inward current to the left (here, blue) and an opposing outward negative current to 

the right (red). If the current passing through the skull or the body is assumed to be negligible, 

one 42 may assume that the sum of the electric field values recorded at all (sufficiently dense 

and evenly distributed) scalp electrodes is always 0 (the average reference assumption). 

Obviously, such an assumption requires the electrodes to be even distributed over the scalp 

which is not the case as some areas of the scalp sport more electrodes than others. To re-

reference the data in EEGLAB, select 

Tools>Re-reference 

This will call the matlab function pop_reref.m and we select ‘compute average reference’ since 

we already didn’t include the data from mastoid channels in the beginning when we imported 

the raw data. 

4.3.3 Extracting Epochs 

To study the event-related EEG dynamics of continuously recorded data, we must extract data 

epochs time locked to events of interest (for example, data epochs time locked to onsets of 

one class of experimental stimuli) by selecting 

Tools > Extract Epochs 
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 In our case these data epochs correspond to the three tasks which we expect to have distinct 

cognitive processes and wish to see whether that is evident via EEG. The epochs can be 

extracted and saved as separate datasets. Already having the events set is useful in extracting 

epochs. For the sake of this explanatory section, we extract the epoch corresponding to Task 

1 from these 43 datasets to be used in the next section. Task 1 lasted for 180 seconds. We shall 

extract the epoch from 30s to 150s as a convention to neglect the boundary effects. 

4.3.4 Filtering the Data 

Filtering transforms the signal and so in an ideal world, we shouldn’t be doing that. However, 

it is often necessary before moving on with data analysis due to several factors. The main 

reason is the removal of the 50Hz line noise (60Hz in the United States). The second reason is 

to remove high and low frequency noise from the data. Moreover, filtering the data removes 

any linear trends from the raw data. EEGLAB allows Finite Impulse Response filtering. Tools > 

Filer the Data > Basic FIR Generally, if the aim is to carry out ERP analysis, the lower and upper 

filter edges are defined as 0.1Hz and 30Hz, respectively. These exact values can vary. This 

bandpass filtering serves the purpose of suppressing the 0Hz offset and the 50Hz DC line 

noise. It is recommended to apply the filters one by one as it is fairly resource intensive 

computationally. To perform this procedure, it is recommended to install the Matlab Signal 

Processing toolbox. 

4.4 Independent Component Analysis (ICA) 

This section gives a brief description of the Independent Component Analysis, how it can be 

performed using EEGLab and how to we deal with the resulting components. It also explains 

why ICA could be helpful for studying our experiment and what approach was used to reject 

unwanted artefacts from our datasets. The dataset of a single task from one of our subjects is 

used to explain the steps carried out for the decomposition and component rejection process. 

4.4.1 What is ICA 

EEG is composed of signals arriving from several sources. These sources could be neural 

activity, blinks, eye movement, muscle movement or pulse. Existing research shows that each 

source projects a unique topographical scalp map and these maps are mixed together 

according to the principle of linear superposition. ICA helps to reverse this superposition into 

independent components or scalp maps that can then be used for research purposes.  

Independent component analysis (ICA) is a very powerful method of separating linearly mixed 

signals from several sensors. In the case of electroencephalogram (EEG), these components 

are artefacts embedded in the data. The decomposition involves changing the basis of the 

data from a data collected from single channels to a spatial basis. In simple terms, original EEG 

data is in the form of rows of data along the time course, each representing the voltage of a 
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single sensor with respect to one or more reference channel. After ICA decomposition the data 

is the time course activity of each component or artefact.  

The mixing process of data from several channels during ICA is passive and linear, hence 

adding no information to the data. Changing the channel order or changing the order in which 

points are plotted has virtually no effect on the algorithms outcome since it has no priori about 

electrode location. 

 
Figure 23 - ICA Decomposition 

The figure above shows how the decomposition outcome looks like visually. The data on the 

left is the orginal EEG data in the form of signals from each channel. Data from each channel 

is divided into components and then mixed with the same components from the other 

available channels. 

4.4.2 Running ICA and component rejection 

EEGLab has built in tools to perform ICA decompositions. To run the algorithm, we simply 

select: 

Tools > Run ICA 

This is followed by a window to select the kind of algorithm we would like to run. For simple 

low density channels the default runica( ) algorithm is recommended. Once the process is 

complete the following window opens up, showing the 2-D spectras of all the components 

extracted. 
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Figure 24 - ICA components 2D spectras 

Note that the scale in the above plot uses arbitrary units. However, the component scalp map 

values multiplied by the component activity time course would give us the same units as the 

data.   

Although the ICA decomposition separates the data into many different linear components, 

before further analysis, it is important to identify and eliminate components that are not 

concurrent with the research objective. In our case, we would like to reject all components that 

are not related to brain or cognitive functions. 

The process of identifying the different types of components maybe a complicated one, but 

existing research and tutorials provided by EEGLab experts make it much simpler. This section 

explains what criteria was used to reject unwanted independent components and determine 

what component is strictly related to brain or cognitive functions. 

The main steps used for identifying components that maybe related to eye movement, blinks, 

muscle movement, noise, channel pops or the brain components are first to analyse the scalp 

maps of each component, followed by the component activity power spectrum. We use the 

figure above (taken from one of our trials) to explain the process.  

Eye artefacts are amongst the easiest to identify. For example, looking at component 3 and 9 

from the above decomposition: 
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Figure 25 - Eye artefacts 

Component 9’s scalp map shows activity concentrated on the far frontal area of the scalp, 

which is very typical of eye movement. While component 3’s scalp map shows a smoothly 

decreasing eeg spectrum which is typically related to blinks. 

Other artefacts that are easy to identify for rejection are components related to muscle activity. 

An example is component 6 from the above decomposition: 

 
Figure 26 - Muscle Artefact 

Muscle artefacts show spatially localized scalp maps, with high activity at those points of 

localization. The above could be due to strong movements of the right jaw or muscles near 

the right ear. 

Another kind of artefact that is easy to identify are due to channel pops. This is when during 

the recording session, a single channel goes off or experiences high amount of channel noise. 

An example from the above decomposition would be component no. 4 and 10: 

 
Figure 27 - Channel pop artefacts 
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Although there would be many components that appear to be brain like, that show scalp maps 

localized in the centre of the scalp. There main criteria for recognizing components that are 

strictly related to brain activity are that they exhibit scalp maps that have single or multiple 

dipoles, and their activity power spectrum shows peaks at typical brain related frequencies (for 

example in the alpha band 7.5 – 12.5 Hz). To show a clear example, we used component no. 4 

of subject 12, during task no. 3, that shows a very clear dipole-like scalp map and exhibits a 

strong alpha band peak at around 10 Hz.  

  

 
Figure 28 - Brain related component 

The above explained criteria was applied on all the data sets to obtain brain/cognitive related 

components for all the data sets that we obtained after the cleaning and decomposition 

process. The process is fairly simple on EEGLab once the ICA has been completed. By selecting: 

Tools>Reject Using ICA>Reject components by map 

We obtain scalp maps of all the components with a button next to it to either accept or reject 

the component. By clicking on each the scalp maps we can also view the activity power 

spectrum graph, which plots the Frequency (Hz) against the Activity Power:  

10 ∗ log10( 𝜇𝑉
2/𝐻𝑧) 

Just like the data cleaning process, the ICA decomposition also leads to rejection of some data 

sets. Some of the data-sets never completed the decomposition process while some gave a 

warning of bad data at the end of the process. To avoid bad data interfering with our final 

evaluation, we decided to not include these data sets in the final analysis. The following table 

represents the final data-sets that were used: 
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Participant Task 1 Task 2 Task 3 

01 Rejected Rejected Rejected 

02 Accepted Accepted Rejected 

03 Accepted Accepted Rejected 

04 Accepted Accepted Accepted 

05 Accepted Accepted Accepted 

06 Rejected Accepted Accepted 

07 Accepted Rejected Accepted 

08 Rejected Accepted Accepted 

09 Rejected Rejected Rejected 

10 Rejected Accepted Accepted 

11 Rejected Rejected Rejected 

12 Accepted Rejected Accepted 

 

Table 5 - Datasets Accepted for final evaluation 
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5. RESULTS 

 

This chapter discusses the results and possible conclusions that can we can arrive to after 

carrying out the data processing and analysis described in the previous chapter. We then try 

to compare our findings with the literature review in chapter 2. 

5.1 Results and Evaluation 

The original aim of this thesis was to design and conduct an experiment that could help 

distinguish EEG patterns for the cognitive functions of analysis and synthesis. After designing 

and conducting the experiment as described in chapter 3 on twelve male individuals we 

obtained initial results in the form of Raw EEG datasets. These datasets then went through a 

long pre-processing pipeline followed by the Independent Component Analysis as described 

in chapter 4. 

The final results were in the form of strictly brain related components for each dataset that 

survived the whole process. The scalp maps and the corresponding activity power spectrum 

were then arranged together for each task to look for possible patterns.  

The following figures show these scalp-maps along with their activity power spectrum, which 

plots the Frequency (Hz) on the x-axis against the Activity Power (y-axis):  

 

10 ∗ log10( 𝜇𝑉
2/𝐻𝑧) 

 

5.1.1 Task 1 Results – Public Transport Problem – Analysis Phase 

Task 1 shows no pattern or possible relationship between the spectrums of different 

participants. Participants 2 and 7 show very flat activity power spectrums, which are typical of 

resting phases. Some participants show peaks at the low frequency band (between 0 -7 Hz) 

that are typical of Delta and Theta bands, while only one of them shows some activity around 

10 Hz (alpha band). In terms of hemisphere activation; only two participants show activation 

of the left region while the remaining four exhibit high activity on the right hemisphere of the 

brain. 
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Figure 29 - Task 1 Scalp Maps and Power spectrum 
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5.1.2 Task 2 Results – Mathematical Problem – Synthesis Phase 

Task 2, once again shows no significant pattern. Participant 5, 6, And 8 show a flat spectrum 

curve that is typical of the resting phases. Although participants 3, 4 and 10 show some activity 

around the 10 Hz frequency of the alpha band – The dissimilarity with other participants leads 

to no significant conclusions or pattern identification. In terms of scalp maps, almost all 

participants show different regions of the brain exhibiting high activity.  
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Figure 30 - Task 2 Scalp Maps and Power Spectrum 

 

5.1.3 Task 3 Results – Alternative Uses Test (ATU) – Synthesis Phase 

The data from Task 3 provided with the most interesting results. Drawing two lines to highlight 

the alpha frequency band (7.5 – 12.5 Hz); a very clear pattern can be seen. Each participant 

shows at least some level of increase in activity within this small band in the form of peaks. As 

pointed out in literature review in Chapter 2; an increase in alpha band has often been 

associated with creativity and divergent thinking. Table 2 and 3 of Chapter 2 also provides a 

summary of existing researches that studied the possible relationship of divergent thinking 

and creativity with alpha band activation and majority of them concluded that there was at 

least some form of increase or event related synchronization of the alpha frequency. Though, 

the magnitude of the peaks is higher in some and lower in others, there is at least some form 

of activation exhibited by each participant. The amount of increase in alpha band activity has 

been linked to the level of creativity or intelligence in some researches but the purpose of our 

research was not to test the intelligence of our participants, but to identify possible EEG 

patterns for each tasks. Another point to be noted is that the scalp maps show activation either 

in the frontal or the posterior region of the scalp, which are typically related to the alpha band 

EEG waves. 
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Figure 31 - Task 3 Scalp Maps and Power Spectrum 
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5.1.4 Conclusion 

There are some apparent conclusions that can be made when one observes these results and 

keeps in mind the nature of each task. It is likely that Task 1 and Task 2 did not induce a similar 

thought process in all our candidates as they were not as straight-forward or precise when 

compared to the nature of Task 3. Task 1 and 2 could be interpreted in different ways, hence 

prompting different approaches and thought processes to solve them. Task 2 consists of both 

divergent and convergent phases and hence the final results could be a mix of data exhibited 

during both these phases.  Task 3, on the other hand, being a popularly used task for design 

research, was the only one that showed identifiable pattern. Since the task is very 

straightforward and famously known for inducing a divergent thought process, all participants 

showed some level of activity in the alpha band which is typical of divergent thinking and 

creativity.  

This highlights the importance of the type of tasks that are selected when designing 

experiments that employ EEG technology. Tasks should be very precise and straightforward so 

that very specific cognitive conditions are simulated in the case of each subject. In our case, 

Task 1 and Task 2 failed to do so as the problems were not straightforward prompting 

participants employ different approaches and consequently exhibiting varying cognitive 

conditions. 

Our initial hypothesis predicted to see distinct patterns for Analysis (Task 1) and Synthesis 

(Task 2 and 3) phases of the design process. An experiment was designed and conducted on 

Male Engineering students to test the hypothesis. Recorded EEG data was processed, cleaned 

and analyzed but as can be clearly seen from the above results, it did not support the 

hypothesis. Although the results did not prove our hypothesis, the presence of some pattern 

in Task 3 and the results being concurrent with most of existing research at least shows that 

there is potential in using Neuroscientific tools for design research. Hence, one can also not 

completely rule out the possibility of studying the Function, Analysis and Evaluation phases of 

the design process by employing different approaches to the experiment and using these 

results as guide towards the design of the experiment. 

5.2 Future research possibilities 

The experiment can vastly be improved by designing tasks that occur over shorter periods of 

time. EEG data sets get exponentially difficult to analyze with time. Having tasks of shorter 

periods also allows evaluating the experiment via other EEG analysis tools as well i.e. Event 

related Potential (ERP), which couldn’t be employed in our case due to the length of the data 

sets. Another recommendation would be to study the design process at an even lower level 

for pattern identification. Instead of studying the different phases of the design process, one 

can start by studying the EEG data exhibited due to different types of thinking i.e. divergent 
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and convergent. We recommend designing the experiment in which the cognitive process of 

interest can be captured over the smallest possible period of time. One way this can be done 

is by taking advantage of existing research [12] on EEG patterns and incorporating such 

patterns in constructing design tasks. 
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7.1 Appendix A 
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7.2 Appendix B 

Towards a Neuroscientific Theory of Design Processes 
Experiment - Consent Form 

Experiment Purpose & Procedure 

The purpose of this experiment is to monitor and explore the similarities and difference in EEG wave patterns 
exhibited during different design tasks. 

The experiment session will last approximately 30 minutes, during which you will be asked to solve three tasks. 
All instructions and required material will be provided before starting the session. 

Please note that none of the tasks is a test of your personal intelligence or ability. The objective is to test the 
usability of our research systems. 

Confidentiality 

Electroencephalography(EEG) will be used to record the electrical activity of the brain. 

All data will be coded so that your anonymity will be protected in any research papers and presentations that 
result from this work. 

(It is possible that some of the recorded data could identify the participant, for example photographs, audio or 
video, and be used for research/presentation purposes. 

Finding out about result 

If interested, you can find out the result of the study by contacting the researcher Waleed Wasti and/or 
Ajmaeen Yawar. They can be contacted via the following email addresses respectively: 
swaleedwasti@gmail.com, ajmaeenyawar@hotmail.com 

 

(the following section can be torn off, and retained by the researcher, with participant keeping above 
information) 

Record of Consent 

Your signature below indicates that you have understood the information about the experiment and consent to 
your participation. The participation is voluntary and you may refuse to answer certain questions on the 
questionnaire and withdraw from the study at any time with no penalty. This does not waive your legal rights. 
You should have received a copy of the consent form for your own record. If you have further questions related 
to this research, please contact the researcher. 

    

_________________ _________________ 

Participant Date 

_________________ _________________ 

Researcher Date 

mailto:swaleedwasti@gmail.com
mailto:ajmaeenyawar@hotmail.com
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7.3 Appendix C 
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7.4 Appendix D 
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7.5 Appendix E 
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7.6 Appendix F 
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